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1. Introduction 

The Sat-View program has been developed by NIWA as an easy to use facility, whether 
at sea or on land, for ordering and analysing NIWA generated sea surface temperature 
(SST) and GMS satellite weather imagery. Both standard and user-defined SST analysis 
areas may be ordered, and when received, displayed on a Windows PC. 
The principal features of the program are as follows. 

�� It operates on a PC running Windows 98, ME, Windows NT4.0, 2000, and later 
versions of these operating systems. 

�� Connects to the web via shipboard satellite communication systems (Inmarsat, 
Iridium, cell phone) and / or standard telephone links from shore. 

�� Provides a wide range of analysis / viewing options for data generated by NIWA. 
�� Provides direct access (i.e., without the use of a web browser) to NIWA’s 

Satellite Data Services (www.niwa.co.nz/services/sat) products. 
�� SST images (and isotherm analyses) for user-defined areas may be obtained by 

simply drawing the required area on a map, specifying the period over which the 
data should be composited, and choosing a ground resolution that minimises 
transmission costs while still providing the best possible information for fisheries 
targeting. 

�� Uses standard email facilities to obtain satellite images from NIWA. 
The operation of the program is described in sections 2–8. The appendices include 
installation instructions, a quick start guide, and outline known program issues. 

2. Starting Sat View -

To start Sat-View, click on the program icon  (on the desktop). 

� message window 

The initial display (above) includes a menu bar that is used to select and set program 
options, a message window that reports results, and the main window. 
�� The menu bar contains the File, View, Options, and Help menus together with 

buttons to select the image magnification, and control display of a user-specified 
anchor point  on the visualised data. Often the anchor point will be set to a ship 
location. 
When an image is opened for viewing (see File option, Section 3) the filename is 
indicated, and, if it is in the NIWA format, a description of the image will be 
displayed too.  

�� The message window is used to provide instructions and information to the user. For 
example, when the left mouse button (MB1) is clicked or held down and the pointer 
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dragged over an image, the latitude, longitude, and image value (e.g., SST) at the 
location of the pointer will be displayed here.  

GIF files that are not in the NIWA format (e.g., the U.S. Naval Research Lab’s ocean 
current analyses from www7320.nrlssc.navy.mil/global_nlom/globalnlom/anz.html) can 
be opened with the Open option in the File menu, but will not appear in the Image 
Selection box displayed by the Select option (under the File menu). Also, it is not 
possible to extract position information or data values by running the pointer over non-
NIWA image data, but they can be zoomed/enlarged, etc. 
When an image is displayed, the preferred magnification setting is Best which gives the 
largest image that will fit within the program window. If this window is resized, the scale 
of the image is adjusted so that the same area is viewed, but it will have a different 
magnification. To specify a particular magnification factor, select one of the 
Magnification buttons (1 to 4). Choosing a Magnification of 1 visualises the data at full 
resolution. If an Anchor location has been specified and the Anchor option is set On, 
then an anchor symbol  will be drawn on top of the image at the position that has been 
specified. 

3. The File Menu 

At present the File menu contains nine options: Select, Open, Ship position, Print, 
Order std products, Update Menu, Recompile menu, Del current image, and Exit.  

�� The Select option brings up the Image selection dialog, which 
allows files in the NIWA format to be selected by their contents, 
rather than their filenames (see Section 3.1). This is normally the 
easiest way to select a particular image for viewing. 

�� The Open option may be used to select and view any GIF file (i.e., 
a file that has been saved as type GIF or gif) if its name is 
known. It is the only way to view files that are not created by 
NIWA. When selected it displays a standard (Windows) file 
selection box from which a file is selected in the usual way. The 
file is then displayed in Best magnification mode so that all the 
data in the file can be seen within the main window.  

Note: A known bug with the File selection dialog is that it may not appear after the 
3D viewer has been used (Section 5.3), and possibly on other occasions too. Under 
these circumstances, exit from Sat-View and start over again. 
The file name and details of the image that has been loaded are displayed on the 
menu bar above the image (as below). Only the filename is present if the file was not 

The Ship position optio

created by NIWA. 

�� n allows the vessel position, or any other reference point, to 
be displayed on the data in the main window via an anchor  symbol. When an 
anchor point has been displayed, the distance between that point and the pointer is 
reported in the message window when the left mouse button (MB1) is pressed, 
together with the latitude and longitude of the pointer, its bearing, and the data value. 
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See Section 3.2 for details of how to use the dialog box that is displayed by this menu 
item. 

�� The Print option is enabled whenever an image is displayed in the main window, but 
is greyed out at other times. When not greyed out, clicking on it brings up the Print 
dialog (Section 3.3) that allows either the whole or the visible part of the current 
image to be printed. If a cross section (see Section 6) has been extracted from the 
data, this may be output on the printed page too. A Print option is also provided on 
the Image view Popup menu (see Section 6).  

�� The Order std products option allows some NIWA Satellite Data Services products 
available from www.niwa.co.nz/services/sat to be ordered without logging onto the 
NIWA website. The dialog boxes used for these requests are described in Section 
3.4. 

�� The Update Menu and Recompile Menu options force internally generated menus 
containing data image details to be refreshed. This normally occurs every 5 minutes, 
but if new data have just been downloaded, then the menus can be updated 
immediately by clicking on Update Menu. 

�� The Recompile Menu option should only be used if there appears to be something 
wrong with the options provided in the Image selection dialog, or you have changed 
the list of folders you want to view (via the Customize menu). This procedure 
generally takes longer as Sat-View must read the contents of each GIF file and 
extract the header information.  

�� The Del current image option 
allows you to delete from your 
computer the image you are 
currently viewing. It is subject to 
confirmation, through the 
following dialog. 

�� The Exit option can be used to exit from Sat-View.  

3.1. The Image selec ion Dialog Box t
This dialog box (see next page) allows files in the NIWA format to be selected according 
to the information contained in them, rather than by filename. (Alternatively, these files 
may be selected through the Open option in the main menu if their filename is known.) 
For the Image selection menu to work properly, the data files must be in one of the 
folders specified in the Customize dialog box (Section 5.4). 
The Image selection box contains three windows where the type of image (Parameter), 
the name of the area covered (Area), and the time for which it is valid (Time) are 
displayed. A list of image types and a map showing standard areas are included in 
Appendix B. For user-selected areas the Area is defined as a string of numbers 
(comprising central latitude and longitude, box width and height, etc.). It is preferable to 
view user-selected areas from the Areas view display (under the View menu item) 
described in Section 4.2. 
To select an image for viewing via the Image selection dialog, work from left to right.  

1) Click on your choice in the Parameter box to display a list of areas in the Area 
box.  

2) Click on an area to display a list of available times.  
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3) Finally, double-click on the Time of interest, or use a single click followed by a 
click on OK, to load the image into the main window.  

If there is only one choice available in each box, it will be automatically selected 
(highlighted) for you. The OK option will only work once all three items have been 
selected. Click on the Cancel option at any time if you no longer want to make a 

The Param

selection. 

eter and Area boxes are sorted into alphabetical order, and usually Times 

ach file in 

 Position Dialog Box 
Shi alog box 

ntered as indicated, in 

ete this operation, or press the Enter (or, on some keyboards, 
Return) key after the longitude is entered. If the details seem to be OK, a message will be 
displayed in the message window, e.g.: 

                                                

are sorted into time order with the most recent data being at the top of the list. 
Note: The selection process may be slow the first time you use Sat-View, as e
the folder(s) specified in the Customize menu has to be read and the details of 
parameter, area, and time selected from it. These are saved for later use – and updated 
every 5 minutes. 

3.2. The Ship
The p position option causes the di
to the right to be displayed, allowing some 
latitude and longitude (perhaps that of the 
vessel) to be entered1.  
The latitude must be e
degrees and whole minutes, followed by S or N, 
e.g., 41 30S or 10N. Longitudes are entered in 
the same way, followed by “E” or “W”. Note 
that the minutes part of the position is optional 
in each case. Whole degrees are quite 
acceptable, e.g., 174E. 
Click on OK to compl

 
1 Note: Sat-View maps and charts are not suitable for vessel navigation, though they may be used for 
fisheries targeting. 
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Ship position set to 41 30S, 174E 
If there appears to be an error, the message will be: 

Invalid latitude/longitude specified for ship position 
Re-enter the position, correcting the previous error.  

If a valid position has been entered, an anchor symbol 
d  location on the image in the main window (if any

by setting the Anchor option back On. 
The anchor position may also be changed from the Image view Popup menu (Section 6), 
or by using the Ship Position dialog box again. 
Note: If two anchor symbols appear o

 will be displayed at the 
specifie ) and all subsequent images 

bar. It may always be viewed again 

n the imagery, change the magnification to a 

f the software. 

ptions on the File menu 
or Image view Popup menu (see Section 6). The Print Image File dialog box has the 

win

is option will be enabled, and printing will be restricted to 

��

age or just the part that is 

��

s a percentage of the 

��

n’t want 

Any modern printer that is capable of printing coloured images should be suitable. 

until the Anchor option is turned Off on the menu 

higher value, then back to the original value – this will remove the stray anchor. This is a 
known bug, and will be fixed in a future release o

3.3. The Print Image File Dialog Box 
Printing the currently displayed image is initiated by the Print o

follo g options available: 
�� Print cross-section allows the visible area of the image shown on the screen to be 

printed with the cross-section graph (Section 6) below it. If a cross-section window is 
present on the screen, th
the visible part of the image (plus the cross-section position and the anchor, if 
present).  
If no cross-section has been drawn on 
the image the choice is between Print 
entire im
currently visible on the screen (Print 
visible area).  
Fraction of page size specifies how 
large the printed image should be. This 
is expressed a
maximum size of image that can be 
drawn on the printer’s page. Usually 
50% will be a good choice, but any 
number between 25 and 100% can be 
selected. A larger number will increase 
the time needed for printing, usually 
without clarifying any of the details in 
the image. 
Use the same printer and settings as 
last time. If you have selected a 
printer before and do to change the settings, leave this box checked and click 

anything, the program will display a standard 
 will need to make your choices. 

on OK. The first time you want to print 
Windows printer selection box, where you
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3.4. Ordering standard products 

ndard products are images that are produced for fixed areas and fixed times of the day 
ompositing periods (if appropriate). They may include SST images, clou

d products are images that are produced for fixed areas and fixed times of the day 
ompositing periods (if appropriate). They may include SST images, clou

Sta
or c d images, 

ilable 
from time to time. A list of the products presently available is given in Appendix C. 

ord he Order standard products dialog box:  

ble).  
Wh
comple  on the Add to order option to ad
To 
through
select A r again etc.  

d yet). 
��

 

or c d images, 
ilable 

from time to time. A list of the products presently available is given in Appendix C. 
ord he Order standard products dialog box:  

ble).  
Wh
comple  on the Add to order option to ad
To 
through
select A r again etc.  

d yet). 
��

 

weather charts (not yet implemented), and other products that may be made avaweather charts (not yet implemented), and other products that may be made ava

The ering procedure makes use of tThe ering procedure makes use of t
The desired item or items should be 
selected from the top down as follows.  

1) Select the Product from the top 

The desired item or items should be 
selected from the top down as follows.  

1) Select the Product from the top 
menu (presently only SST and SAT 
IR); 
menu (presently only SST and SAT 
IR); 

2) Next, the Area from the middle 
menu;  

2) Next, the Area from the middle 
menu;  

3) Finally the Time from the bottom 
menu (presently just the latest 
availa

3) Finally the Time from the bottom 
menu (presently just the latest 
availa

en the Time selection has been 
ted click

en the Time selection has been 
ted click d this request to your shopping basket. d this request to your shopping basket. 

add another product, go 
 steps 1 – 3 again, and 
dd to orde

add another product, go 
 steps 1 – 3 again, and 
dd to orde

Finally, select the Send order 
option. This brings up the 
Standard product 
confirmation box which lists 
the standard items included in 
your shopping basket and 
provides three options: 

�� Send it  transmits 
the order to NIWA. 

�� Add more  allows 
other items to be added 
(not implemente

Finally, select the Send order 
option. This brings up the 
Standard product 
confirmation box which lists 
the standard items included in 
your shopping basket and 
provides three options: 

�� Send it  transmits 
the order to NIWA. 

�� Add more  allows 
other items to be added 
(not implemente
Cancel  removes 
this dialog box from the screen
to. 

Cancel  removes 
this dialog box from the screen
to. 

 but your order remains intact and may be added but your order remains intact and may be added

 it option, you must have logged onto the Internet. To
ou should log off (the Internet) as soon as the mail

Not B  e: efore selecting the Send
 your Internet charges, y
e has been sent. This u

reduce  
messag sually takes only a few seconds, and is signalled by the 
disappearance of the black popup window. If a failure occurs while sending, it will try 

ve times. up to fi
The order is sent to NIWA via email using the communications method set up in your 
customization options (Section 5.4). The results will be sent back to you via email, 
generally within 60 minutes, for storage in one of your folders. 
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4. The View Menu 

The View menu has only two options, Image and Areas. These options 
determine what information is shown in the main window, effectively 

t-View between two viewing modes. 
�� e option displays the currently selected image (obtained via the 

o

e -selected areas outlined by 
d c

t
(MB

4.1

n be manipulated using the Image view Popup menu 
(initiated by clicking the right mouse button (MB2) inside the main window). If the Best 
o as been selected, the image will first be displayed at the 
maximum size that allows it all to be viewed in the main window. If that window is 

le. This area is then displayed at the maximum magnification that will fit within 

e
Sec

4.2

user-defined areas. This is because under this option these areas are 
displayed as rectangles over a regional map (called a basemap). This 

 to update SST analyses on existing user-defined 

ie

a ather  
ou

switching Sa
The Imag

r Open options in the File menu – as explained above). This is the default 
g mode of Sat-View.  
as option displays a map with the all previous user

Select 
operatin

�� The Ar
coloure  re tangles, so that a particular area may be selected for display or update, 
etc. This is the best way to view the data for an area you have defined. The procedure 
is described in Section 4.2. 

Bo h the View and Areas displays provide Popup menus when the right mouse button 
2) is clicked (see Section 6). 

. The Image View 
When in Image mode you will normally view the data using the Select menu (described 
in Section 3.1). The data may the

ption (on the menu bar) h

resized with the Best option on, the image will be rescaled to fit the new window size. 
Otherwise the image stays at the Magnification (1-4) specified on the menu bar. 
Other options controlling the image display can be selected from the Popup (MB2) 
menu.  
�� New Centre causes the image to be centered (at its current magnification) at the 

location where the pointer was when the right mouse button was clicked.  
�� Select View allows a rectangle to be drawn on the part of the image that is currently 

visib
the image window. This is the best method to enlarge a section of an analysis. To see 
the whole image again – click on the Best button again. 

Th se options are described in more detail in the Image view Popup menu section (see 
tion 6). 

. The Areas View 
The Areas view mode provides the best method of viewing the data in 

option in the V
Popup menu. 
In Areas mode 
image, and the 

display is also used
areas and to create new areas for which SST data are required. 
The basemap and user-defined areas display is accessed by the Areas 
w menu described above, or from Display Areas in the Image view 

 basemap is displayed in place of the usual SST or satellite we
tlines of previously received user-defined data areas are plotted on top 
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of it2. You can magnify a section of this map using either the magnification buttons 
above the image, or the Select Area option in the Popup menu. 

e 

ndicate ages of 1–7 and 8+ days 

here more than one image is available for a 

A s om the Areas display appears to the 
h

bee
des  

 

 
 

 item on the Popup 

The User-selected area dialog box, 
shown on the right, appears 
whenever a user-defined area is 
selected by either of the methods 
described above. It may be closed 
when no longer required, but will 
reappear on the screen at its 
previous position if needed again. 
The title of the box indicates the 
computer generated name of the 
                                                

The Areas view Popup menu contains the same New Centre and Select View options 
as in the Image view Popup menu. The Select Area option allows one of the user-
defined areas (displayed as a coloured rectangle) to be selected., while Draw New 
provides a way to “draw” (or define) a new user defined area on the basemap (se
section 4.3). The Display Image option switches back to the last SST or satellite cloud 
image viewed. 
The rectangles are drawn in colours indicating their 
age. 
�� Brown, red, orange, yellow, green, blue, violet 

and gray i
respectively.  

�� W
given area, further rectangles in the appropriate 
colour are drawn inside, giving a thicker outline. 
mall section fr

rig t. To pick an area after the Select Area option has 
n selected, click the left mouse button inside the 
ired rectangle. Alternatively, press the left mouse

button and drag it over the basemap until the border 
of the rectangle you want changes colour, then rele
different type of arrow when you are able to make this s
Where the rectangles overlap, it may be necessary to m
rectangle you want until its borders, rather than thos
change colour (it is often useful to magnify this region on the map – either by one of the 
Magnification buttons, or better still, by using the Select View

ase it. The pointer changes to a
election. 
ove the pointer around inside the
e of any overlapping rectangles,

menu). If not already displayed, the User-selected area dialog box then appears on the 
screen making a number of choices available, and the pointer returns to its normal shape. 
The options that become available 
are described in the following 
sections. 

4.3. The User-selected area 
Dialog Box 

 
2 Note: Area outline(s) only appear on the Areas display after data for the specified area(s) have been 
received and written to the folder specified in the Customize option.  
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user-defined area (in this example 3251755020028001431), to which the information 

�� ot greyed out), provides an animated sequence of images 
selected from the date list. See the Looping Images section (5.1) for details. 

�� Delete will delete (from your 

��

efore ordering a new image. 

then release the button. The contents of the User-
nd you can repeat any of the options described 

��  box. When needed again it will reappear at its 

4 g Dialog Box 
The alog box provides details of the image currently 
sele ge or insert other options before updating an 
exis ata for a new area. This dialog box shows the 
foll
��  of the current image. At present only SST data are 

�� ive the central latitude and longitude of the user-

��  height and width of the user-selected area to the 
ither these values nor the central latitude and longitude may be 

changed – except by drawing a new area on the Areas display basemap. 

below applies. 
The dialog box provides a list of all images available for the user-defined area. The data 
are displayed in descending order by date, so that the most recent image appears at the 
top of the box. If it is the only image for this area, it is automatically selected (i.e., 
highlighted) as in the example shown here. 
The options on the right side of the dialog box provide the following functions. 
�� Details displays the Image Details dialog box (described below), which provides all 

relevant details of the image, and gives the opportunity to order another SST analysis 
for the same area. 

�� Display displays the SST analysis for the date selected from the list. 
�� Reset clears all selections in the date list. 

Loop, if enabled (i.e., n

computer) all the images 
selected (i.e. highlighted) from 
the date list. As usual, 
confirmation is required, and 
another box appears, where you 
must select the Delete option to com
Draw New allows you to define a 
mouse button (MB1) down at on
opposite corner, and then releasin
displayed in which you should enter any special details b

plete the operation. 
new area in the usual way, by pressing the left 

e corner of the desired rectangle, moving to the 
g the button. The Image Details dialog box is then 

�� Pick Another works in the same way as the Select Area option on the Areas view 
Popup menu. Drag the mouse with the left button down until the border of the area 
you want to select changes colour, 
selected area dialog box change a
here. 
Cancel simply closes the dialog
previous position. 

4. . The Image details & orderin
 Image details & ordering di
cted, and the opportunity to chan
ting analysis area or ordering d
owing information. 
Image type will be set to the type
available. 
Central Lat and Central Lon g
selected area to the nearest 0.1�. 
Lat range and Lon range give the
nearest 0.1�. Ne
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�� Last date specifies the most 

recent date to be included in the 
composite image (usually this 
will be today’s date – but it can 
e re the 

: If this dialog 

d gives the 

 the resulting analysis 
will be cloud free – but it may 

g period for NIWA SST products is 3 days. 

 with the 

e exceeded. If you specified a resolution of less than 1 km it will be 

��

being ordered. It is 

free. The default value is 
specified in the user 
customisation file, along 

b up to 2 months befo
present date). Note
box resulted from a Select Area 
or Pick Another operation then 
the Last date will be the last date 
of the image data you selected. 
To order an updated analysis you 
must change this to the current 
date (or whatever is desired). 

�� Compositing perio
numbers of days to be 
composited (analysed) in the SST 
data. The longer this period, the 
more likely

not indicate present conditions as well as a shorter (possibly more cloud blanked) 
analysis. The standard compositin

�� Max image size allows an upper limit to be put on the size of an image to be ordered, 
thereby limiting transmission costs. This will typically be 16K (16000 bytes), 28K 
(28000 bytes), or 32K (32000 bytes). The ground Resolution achievable
Max image size chosen is also indicated. Note: There is no point in asking for a 
resolution below 1 km as this is the best the satellite can achieve. Generally it is 
preferable to reduce the image size as far as possible while still achieving the 
required ground resolution. This is a key feature of the NIWA Sat-View system. 
Note that the maximum image size and maximum resolution are absolute limits that 
will not b
increased to 1 km during processing at NIWA. 
Max cloud cover indicates 
the maximum cloud cover 
that is acceptable in the 
product 
expressed as the percentage 
of the requested analysis 
area that may be obscured 
by cloud. If 100 is specified 
then an analysis will be sent 
even if the area in question 
is completely cloud covered. 
Similarly a value of 0 will 
result in an analysis being 
sent only if the chosen area 
is completely cloud (or land) 
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with the default maximum image size. Both may be edited in the Image Details & 
Ordering dialog box, along with any other numbers that appear in a box with a 
white background. 
If the NIWA data processing system determines that there is more cloud cover over 
the user-defined area than that specified here, a message will be sent to the user 
indicating the actual percentage cloud cover. The area may then be re-ordered using a 
number greater than the value reported by NIWA. 
e: For the purposes of the cloud cover calculation (at NIWA), any land in the arNot ea 

is c
for
If t
upd e. This first brings up the Image 

already logged onto the Internet click 

ounted as cloud. When ordering data for a coastal area you should make allowance 
 this when setting the Max cloud cover value. 
he most recent image does not include data received in the last 24 hours, the Order 
ate option may be pressed to order a new imag

order confirmation dialog box (previous page) that confirms the options you have 
selected. 
If you are happy with these details and you have 
on Send it to request an updated analysis from your information provider (i.e. NIWA). 
Otherwise click on Cancel (and try again). 
Note: Before selecting the Send it option, you must have logged onto the Internet. To 
reduce your Internet charges, you should log off (the Internet) as soon as the mail 
message has been sent. This usually takes only a few seconds, and is signalled by the 
disappearance of the black popup window. If a failure occurs while sending, it will try 
up to five times. 
Your request will be formatted as an Internet message and sent off using your designated 
communications system (set in the Customize (Section 5.4) dialog box). It will be 
processed and sent back to you by the same method (about 60 minutes later).  
To receive the data, you will need to check your incoming mail (usually the new data 
will be available within 1 hour of the request being sent) and save the attached image 

dentify the 
available for use within 5 minutes of it being stored – 
u update using the Update Menu option, see Section 

comprises four options: Loop, Colour scale, Show 
Customize. 
n is enabled if the image currently displayed in the 

s available at more than one time. See the Looping 
ction 5.1) for details. 
le menu allows the original colour scale of the image 

                                                

into one of the folders you specified in the Customize dialog box. The name given to the 
image when it is saved is not important (but it must be of type GIF (or gif)) providing it 
is not the same as that of another image you wish to keep3. Sat-View will i
image by its contents and make it 
or you can force an immediate men
3) 

5. The Options Menu 

The Options menu 
3D, Cancel 3D, and 
�� The Loop optio

main window i
images topic (Se

�� The Colour sca

 
3 Appendix E ( ) provides guidance on how to extract data from 
email messages. 

Quick Start Guide for Sat-View and Email
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to be changed to another predefined colour scale. Its application is described in 
section 5.2 under Changing Colour Scales. 

�� The Show 3D and Cancel 3D options provide a three-dimensional view of the image 
displayed re also available in the Image view Popup 
Menu whe  This facility does not show the temperature 
at depth – 

�� Use of the detail in Customization Options (Section 
5.4). 

5.1. Looping I
A set of image o
that

e Areas display, and there are two or 

Alt
you have selected a standard NIWA area for display (e.g., Brett), and there are 

at least two times available for this area, the Loop option in the Options menu 
w  bring up the Loop Control dialog box, and make 

in the main window, and a
re their use is described. Note:
it only represents the surface SST as though it were a 3D image. 
Customize option is described in 

mages (Animation) 
s f r either a standard NIWA analysis area (SST or cloud imagery), or one 

 has been defined by the user may be animated (or looped) as follows.  
1) When an area has been selected from th

more times available (for that area), select the items in the list that you would like 
to loop. If at least two times are selected from the list, the Loop option on the 
Area Dialog Box will be enabled. Click on this to bring up the Loop control 
dialog box. 

ernatively:  
2) If 

ill be enabled. Click on this to
all images available for looping. 

The Loop Control dialog box is shown below. 
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On the left it contains a list of the images (with the most recent at the top) that are 
available for inclusion in the animation (or loop). All are initially selected, but this 
selection may be changed at any time by clicking on the item to be selected or 
deselected. In addition there is a speed control that may be changed at any time, and an 
indicator that shows how far you have progressed through the loop. 
Initially the oldest image will be displayed on the right. Beneath it are four options 
whose operation is straightforward. Start and Stop will start and stop the looping, while 
repeated clicking on Pause will stop and start the loop alternately. Cancel exits from the 
loop and closes the Loop Control dialog box. 
The colour scale used for all images is the same (regardless of the colours in the original 
images), so that changes over time are easier to monitor. Normally this colour scale is 
taken from the latest image in the sequence and if you are happy with the image colours, 
there is no need to do anything more. Otherwise two additional options are provided 
within the Colour scale options section of the dialog (below the Speed control).  
�� The left option From Image allows you to select any of the images in the list and use 

its colour scale – for example you may prefer to use the colours from the earliest 
image in the sequence or one in the middle. Note: If you click on the From Image 
option, the pointer will be moved into the Image Selection list and you will not be 
able to move it outside this area until you have selected one of the images. 

�� The From Table option will load the Colour Table menu box, as described in 
Section 5.2. Select one of these standard colour tables if you wish, and it will be 
applied to all images in the loop. Both this and the From Image options may be 
selected at any time, regardless of whether the loop is running. 

Hint: To view the images one at a time in sequence, run the loop at low speed and use 
the Pause option to stop the loop after each image is displayed. Use the Pause option 
again to initiate loading of the next image. 

5.2. Changing Colour Scales 
Usually the data files being displayed will have been constructed 
with a colour scale that varies over time. This allows the full 
range of colours to be used over the region displayed. If an 
alternative colour scale is preferred, perhaps to assign fixed 

colours to particular temperatures, or to give maximum contrast over a limited 
temperature range, then it will be 
necessary to change the original 
colour scale of the image.  
Sat-View allows the user to do 
this. The method is as follows. 
Once an image has been loaded 
into the main window, the 
Options menu provides access 
to two commands via the Colour 
scale option.  
The two options Select and 
Reset provide for a new scale to 
be selected or the original scale 
restored, respectively. The 
options will be greyed out and 
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inactive at times when it is not appropriate to use them – before an image is displayed, 
for example. 
�� The Select option causes the Colour map selection dialog box to be displayed that 

lists all colour scales available for this particular type of image.  
When a different colour scale has already been applied, it will be highlighted on the 
list. To choose another colour scale, click on the line containing its description so 
that it is highlighted, and click on OK. A quicker option is to double-click on the 
item you want. If you decide not to change the colour scale at all, click on Cancel. 

�� To restore the original colour scale built into the image, choose the Reset option in 
the Options, Colour scale menu. 

Note: It is not possible to change the colours of the overlays showing coastlines, latitude, 
and longitude. They may be hard to see for some colour scales, but positions may be read 
at all times by using the left mouse button (MB1). A description of the standard colour 
scales is given in Appendix D. 
Note: If this colour scale option does not work at all, or you get error messages, consult 
the person who installed the program. Some or all of the files may be missing. 

5.3. 3D Image Viewing 
Occasionally it may be helpful to view an SST image in a 3-D display. This will 
emphasise gradients 
in sea temperature 
by showing them as 
height differences 
as well as changes 
in colour. The 
Compaq array 
viewer software is 
used for this 
application and it is 
activated from the 
Image view Popup 
menu described 
previously (Section 
6). This general 
purpose viewer has 
many options which 
are described in its 
associated help file. 
However two main 
points should be 
kept in mind. 
1. To rotate the image, imagine it contained in a transparent sphere. Moving the mouse 

2.  array values, separated from the 

on to some point on this imaginary sphere and then dragging it with the left button 
down will change the viewing angle for the image. 
The upper part of the window may contain numeric
3D image by the grey pane divider. If you wish to get rid of these, click the left 
mouse button on the divider and drag it up to the top of the display area. 
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To exit from the viewer, it is preferable to use the Cancel3D option on the Popup Menu. 

5.4. Custom zation Options i
Following program installation, or whenever a change is required, the Customize option 
in the Options menu should be selected to display the User options dialog box. 
This provides the opportunity to 
change or define a number of 
variables used by Sat-View. 
�� Data Provider specifies the 

Internet address where 
requests for new images are 
to be sent. In the New 
Zealand region, the address 
required is sst@niwa.co.nz. 

�� Company ID is the ID 
assigned to your company 
when you register to use this 
service. It is 1–3 digits long. 

�� Vessel ID, also 1–3 digits, is 
the ID assigned to your 
vessel or office, and together 
with the Company ID will 
make a unique combination. 
Note: NIWA provides the 
Company and Vessel IDs 
when a user registers for this 
service. They should not be 
revealed to other users. 

�� The Communications 
options specify how messages should be sent to the Data Provider. Use POP for a 
standard Internet connection (for example with the Iridium system or by a normal 
telephone line) and STRATOS if you have this software for use with Inmarsat-C.  

�� The Message Directory is the folder where requests for imagery are stored before 
being sent to your Data Provider. Consult with your IT Support (if you have any!) 
to specify the correct folder. Usually this should be a c:\temp. If this folder does 
not exist on your PC, you will need to use the Windows Explorer program to make it.  

�� Basemap Name specifies which GIF file of those available in the c:\Program 
Files\Sat-View folder should be used as a background for the user-defined 
image areas. For the New Zealand region this will normally be nzregion. If your 
area of interest is not covered by this map, then replace nzregion with sst_ll, 
which provides access to the entire NIWA SST analysis region. 

�� The Max Image Size specifies the maximum image size you will normally want to 
request from your Data Provider. Various options with increasing transmission cost 
may be selected. When actually requesting an SST image on a user-defined area you 
should choose the smallest size that yields the required resolution for the selected 
area. (See the discussion in section 4.4). Note: When ordering Standard NIWA 
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products, this constraint is not applied. Usually these will be much larger because 
they cover larger areas and have relatively high ground resolution. 

�� Max Cloud Cover specifies the maximum percentage of cloud cover that is 
normally acceptable over your area of interest. As with the Max Image Size it may 
be set to another value when you actually request an image (see Section 4.3). 
Typically a value of 20 (i.e., 20%) may be acceptable. (Remember that any land 
within the area will be counted as cloud cover.) 

�� The Directories to be searched for images box is used to specify which folders on 
your disk(s) should be checked for images that may be viewed by Sat-View. As 
described in the Installation Instructions you should enter the list of folders to be 
searched for files to be displayed. If you use any folders other than the default of 
c:\niwa\data, they should be entered in this list. 

Click on the Save Options option to save your choices, or Cancel to leave them as they 
were. 

6. Cross Sections (Locating Temperature Breaks) 

Cross-sections, or profiles of SST 
along a line drawn on a SST chart (a 
powerful method to identify 
temperature breaks) may be obtained 
as follows.  
From the Image view Popup menu 
select the Draw Xsection option. 
Then indicate the line of the cross-
section as follows. 
Move the pointer to the start point, 
then drag it to the end point while 
holding the left mouse button (MB1) 
down. When the mouse button is 
released a new window is displayed, 
plotting the temperatures along the 
cross section line. An arrow is drawn 

on the SST chart to indicate the line 
that you selected (see right). 
The Temperature Cross Section 
window (see right) indicates the 
temperature values read from the 
image versus the distance along the 
cross-section line (i.e., arrow). There 
are two lines drawn in red – a thin line 
indicating actual values and a thicker 
line to which smoothing over a 5 km 
interval has been applied. If the 
temperature range is large enough, it 
will be hard to distinguish between 
the two red lines. 
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If the left mouse button is pressed down as the pointer is dragged along the cross-section 
window, the value and position corresponding to its distance along the cross-section line 
are displayed in the message window. This display is similar to what would be obtained 
by dragging the mouse over the SST image itself. In addition a small diamond shaped 
symbol moves along the cross-section line drawn on the image, so that the any point on 
the cross section window can be matched with its location in the main window. 
The cross-section window may be moved to any location on the screen, and if closed will 
reappear at its previous position when needed again. The temperature scale is chosen to 
best represent the values measured along the cross-section line (so will be different for 
each use of this tool). The right hand end of the cross-section is indicated by the arrow 
head, and the barbs across the arrow are drawn to match the vertical grid lines in the 
cross-section window. 
To change the cross-section line, use the Draw Xsection option on the Popup menu and 
draw another line on the SST chart. 

7. The Image view Popup Menu 

This Popup menu is activated when in Image view mode by clicking the 
right mouse button (MB2). It will appear near the location of the pointer. 
Items on this menu 
may be selected by 
clicking on the 
desired item using 
the left mouse 
button. 

�� Set Anchor will display a 
small anchor symbol  on the 
image at the point where the 
right mouse button was clicked. This provides a reference point for navigation, and if 
the left mouse button (MB1) is subsequently clicked or dragged across the image the 
bearing and distance of the point on the image from the anchor will be displayed in 
the message box (see example on the next page). 
If the anchor is not set, the bearing and 
distance will not be included in the 
message when the left mouse button is 
clicked or dragged over the image. 

�� New Centre will place the point where 
the right mouse button was clicked (to 
bring up the menu) at the centre of the 
viewing area. It will stay there whatever 
magnification is selected. 

�� Select View will allow you to display a 
limited area of the image with the 
highest possible magnification that 
keeps it all within the main window 
(display area).  
If you select this option, the pointer 
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changes to a crosshair. Pick the location of one corner of the rectangle you want to 
display, press the left mouse button (MB1) down, then drag the crosshair pointer to 
the opposite corner of the rectangle and release it. As you drag the pointer over the 
image, a small rectangle is drawn over the top of it indicating the area selected. 
When the left mouse button is released, the screen is redrawn to give the best 
magnification to the selected area. 

�� Display areas will bring up the alternative Areas display as described in section 4.2 
and will show the current (user-defined) image areas that you have stored, and allow 
you to request new ones. 

�� Print provides an alternative way of displaying the print dialog box (see section 3.3), 
to obtain hard copy on an image (and cross-section, if present). 

�� Show3D will cause a new window to be displayed containing a 3-dimensional plot of 
the current image as described in the 3D Image Viewing (section 5.3). 

�� Cancel3D will remove the 3D plot window from the screen. Use of this option either 
on the Popup menu or under Options (on the menu bar) should be the normal 
procedure for deleting the 3D window, rather than clicking on the � at its top right 
corner. If the Show3D option is greyed out, it will be necessary to click on the 
Cancel3D option to re-activate it.  

8.  The Help Menu 

The Help menu provides full documentation on program installation, 
customization, and operation of the program. Its use is self-explanatory.  
Selection of each subject will bring up the same material as presented in 
this user manual. 
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Appendix A Installation and Update Instructions 

Updating Sat-View 
To update to a new version of Sat-View,  

�� load the CD-ROM,  
�� use Windows Explorer to view the contents on the CD (usually this is Drive D)  
�� locate the program update and double click on it. 

No other information is required. 
Note: Do not run the update program if an earlier version of Sat-View is not already 
installed. 

Installing Sat-View 
Before installing Sat-View (for the first time) you must have the following
information: 

�� Your email address; 
�� Your SMTP server address (as supplied by your ISP); and 
�� Your Company and Vessel identifiers (supplied by NIWA). 

Do not proceed with the installation until you have all of the above information. 
 
Once you have this information install Sat-View by inserting the CD into the drive then, 
using Windows Explorer, double-click on setup.exe in the root directory of the CD 
(probably the D: drive).  Alternatively  

1) click on the Start option on the task bar 
2) Click on Run 
3) Type in D:\setup in the box (assuming the CD Drive is D) 

This will open a window with instructions to guide you through the installation 
procedure. 
The following is an example output from the installation window with informational 
instructions highlighted thus and the answers you need to provide highlighted in yellow.  
Replace the email address with that provided by your Internet Service Provider (ISP), 
and the company and vessel ids with those provided by NIWA.  
 
 NIWA SAT-View Installation Procedure v2.2 
 Info:  Installing from disk D: 
 Info:  The preferred location for the program is "C:\Program Files\Sat_View" 
 Info:  If you are happy with this choice just hit the Return key to 
 Info:  answer the next question... 
 Query: Enter preferred location for program or hit Return for default?:� Just press “Enter” key 
 Info:  Program directories created - copying files 
 Info:  SAT-View.exe copied OK 
 Info:  Help File copied OK 
 Info:  Basemap copied OK 
 Info:  Basemap Grid copied OK 
 Info:  Initial display copied OK 
 Info:  Standard Products text file copied 
 Info:  Colour table information copied OK 
 Info:  Examples copied OK 
 Query: Will you be sending information requests via the Internet? [Y/N]: Y 
 Info:  Copying blat to C:\Windows 
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 Query: What is your email address (e.g. bloggs@actrix.co.nz)?: my.vessel@actrix.co.nz 
 Info:  We assume your SMTP address is smtp.actrix.co.nz 
 Info:  If this is OK just hit the RETURN key on the next line  
 Query: Enter your SMTP address or hit RETURN for default:?:� Just press “Enter” key 
Failed to open registry key for Blat profile , using default This is normal – ignore 
 
SMTP server set to smtp.actrix.co.nz on port 25 with user my.vessel@actrix.co.nz, retry 5 time(s) 
 Info: 
 Info:  You need to be connected to the internet to send a test message 
 Info:  If you would like to do this, make the connection then answer Yes below 
 Query: If now connected, would you like to send a test message? [Y/N]: N 
 Info: 
 Info:   Installing the Fortan run-time libraries. 
 Info:   Please click on any [NEXT] or [I Accept] buttons 
 Info:   that may appear.  Once the run-time libraries have 
 Info:   been installed, click on the [Finish] button 
 Press the Enter Key to continue:   � Just press “Enter” key 
  

The Run-Time Library installation window will eventually appear.  When it does, 
�� Click on [Next] to start the installation 
�� Click on [Next] when the window showing the files to be installed appears 
�� Click on [Finish] to complete the installation.   
�� Click on the installation window and press the enter key as requested to continue the 

installation 
Info:  Libraries being installed now ... Follow instructions above 
 Info: 
 Info:  Installing the Compaq Array Viewer 
 Info:  After the installation has completed go to the Windows Start menu,  
 Info:  find and click on "Array Viewer" 
 Info:  When the program runs, look for the grey bar dividing the viewing 
 Info:  window. Hold the left mouse button down with the pointer over it and 
 Info:  drag it up as far as it will go to avoid seeing numbers in future... 
 Info: 
 Info:     Please click on [FINISH] to start the installation of 
 Info:   the Array Viewer.  Click on any [NEXT] or [I Accept] button 
 Info:   that may appear. 
 Info:     If the installation asks to "Restart my computer now" 
 Info:   then select "No, I will restart my computer later", then 
 Info:   click on the [Finish] button. 
 Info:     Otherwise untick the button that asks if you wish to "view 
 Info:   the ReadMe file now", then click on [Finish] 
 Press the Enter Key to continue: � Just press “Enter” key 
 

The first Array Viewer installation window will eventually appear.  When it does, 
�� Click on the [Finish] button to start the installation of the array viewer. 
�� Wait until the second Array Viewer installation window appears. 
�� Click on the [Next] button on the installation Welcome window 
�� Click on the [Next] button on the window requesting the destination path 
�� Click on the [I Accept] button on the window displaying the license information 
�� Click on [Next] to the Select Folder window 
�� If the installation asks to “restart my computer now”, select the  “No, I will restart 

my computer later” option and click on the [Finish] button, otherwise uncheck the 
“view ReadMe file” option, then  click on the [Finish] button on the Setup Complete 
window. 

�� Return to (ie click on) the original install window to continue the installation. 
 
Info:   Installing Viewer now ... - please follow above instructions 
 Info:  Now will set up the program defaults 
 Query: Enter the company ID you have been assigned (1-3 digits)?: 999 
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 Query: Enter the vessel ID you have been assigned (1-3 digits)?: 99 
 Info:  This information has been written successfully. You may change it when 
 Info:  SAT-View is running through the Customise menu option. 
 Info: 
 Info:  We will now ask you to make a short cut to the SAT-View program so that 
 Info:  you can start it easily from your desk top. Please do the following: 
 Info:  1. Use Windows Explorer to find C:\Program Files\Sat_View\Sat_View.exe 
 Info:  2. Click on it using your right mouse button 
 Info:  3. Select the Copy option from the popup menu 
 Info:  4. Move cursor to a spot on your desktop where you want the shortcut 
 Info:  5. Click right mouse button, select "Paste Shortcut" from popup menu 
 Info:     Now Press Enter to finish 
 Press the Enter Key to continue:   �Read instructions and Press "Enter" key 
 Info:  All done  
 
 

The installation window will close and the installation is complete. 
Create the shortcut as suggested above and then reboot the computer if this has been 
suggested during the installation process. 
Run the Compaq Array Viewer utility to initialise it.  If this program has not been run at 
least once, the Show3D option will not work.  To run the program click on the Start 
button, select Programs then select Compaq Array Visualizer 1. Click on Array 
Viewer to run the program.  Once the Array Viewer program has run, look for the grey 
bar dividing the viewing window. Hold the left mouse button down with the cursor over 
it and drag it up as far as it will go to avoid seeing numbers in future. Close the 
application – it should now operate correctly from the Sat-View program. 

Installing Pegasus Mail (Optional) 

 

Before installing Pegasus Mail you must have the following information: 
�� Your email address; 
�� Your username and password (as supplied by your ISP); 
�� Your SMTP server address (as supplied by your ISP); and 
�� Your POP server address (as supplied by your ISP). 

Do not proceed with the installation until you have all of the above information.

 
The Pegasus Mail installation kit is included with the Sat-View distribution CD in the 
Pegasus Mail directory. There are two versions there, v312c and v401a.  The instructions 
in this manual are for the v312c installation.   
To install the Pegasus Mail client, insert the CD into the CD drive, use Windows 
Explorer to locate the installation file D:\Pmail\v312c\w32-312c.exe where D: 
is the drive letter for the CD-ROM drive.  Start the installation by double-clicking on this 
file. 

1. Click Next on the first informational box; 
2. Click Next on the second informational box; 
3. Note the default installation directory shown, then Click Next to accept the 

default; 
4. Click Next to accept the default components; 
5. Click Next to accept the default Program Group (ie where it appears under 

the Start menu); 
6. Click Next at the Ready to Install!  box. 
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The installation process will then begin to install the program. Click on Finish to 
complete the installation. 
Next install wsndto10.exe by double-clicking on this program. 

1. Click Next at the informational box 
2. If the Select Destination Directory shows c:\Program Files\Pmail 

(as noted in 3 above). If this is not the correct directory, then Click Browse 
change the directory to that noted in 3. 

3. If the Message Box saying, for example, The directory 
c:\Program Files\Pmail already exists, would you like to install 
into that directory anyway appears, click on Yes. 

4. Click on Next to select the directory 
5. Click on Next to start the installation. 
6. Click on Finish to complete the installation. 

Program wsndto10.exe is not required for Version 4 of Pegasus Mail (i.e. v401a). 

Configuring Pegasus Mail 
Once Pegasus Mail is installed, it needs to be configured. The program will guide the 
user through this when it is run for the first time. 
Start Pegasus Mail (from the Start Menu, Programs, Pegasus Mail for Win32). 

1) Click on the Click on here if there will only ever be one person running 
Pegasus icon; 

2) Accept the default directory (Click on OK) if this is acceptable, (or change it to 
another location, if preferred);  

3) This will start the Internet Startup Wizard. Click on Next; 
4) Enter your email address (e.g., my.vessel@actrix.co.nz). This should be the same 

address that is used when installing Blat (see above). Click on Next; 
5) Enter the address of your POP3 server. You will need to consult your Internet 

Service Provider (ISP) for this. Normally it will be something like 
pop3.actrix.co.nz, then click on Next; 

6) Enter the username and password supplied by your ISP. Click on Next; 
7) Enter the address of the SMTP server. This should be supplied by your ISP and 

should be the SMTP address used during the Blat installation above (e.g., 
smtp.actrix.co.nz); 

8) From the How do you connect to the Internet window, select Network (i.e., 
click and highlight the Network radial option button, then click Next; 

9) Click on Finish. 
10) Lastly, adjust the Network timeout period. 

a) Start Pegasus 
b) Click on Tools 
c) Click on Internet options 
d) Change the Timeout for network connections from 15 seconds to 120 

seconds. 
e) Click on OK 
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This setup is adequate for using Pegasus Mail to download the requested images from 
your ISP once you have made a connection to the Internet. If you wish to use Pegasus 
Mail as a general-purpose email client for sending and receiving email, some of the 
additional features may need to be configured. This is outside of the scope of this 
document, but the options and help for these options are found under the Tools menu. 
Note that with this configuration, outgoing email is queued until the internet connection 

is established and queued emails are sent by clicking on the send-mail icon . Pegasus 
Mail also has a Selective mail download facility to allow the user to download only the 
header information so that unwanted email can be deleted and only the email required 
downloaded. This is a useful utility when connected to a slow internet link and can be 
found under the File menu. For more information on using Pegasus Mail (including the 
selective download capabilities) see Appendix E (Quick Start Guide for Sat-View and 
Email). 

Example Data Products 
The standard installation will create the folder c:\niwa\data\examples and copy 
into that folder a number of files containing sample data (including an SST climatology 
for the region). If under the Customize option the Directories to be searched for (see 
Section 5.4) includes a reference to the folder c:\niwa\data\examples, then the 
example data will immediately be available for experimentation. 
To prevent these data from always appearing in the Image selection dialog, merely 
remove the reference to c:\niwa\data\examples in the Customize dialog. 
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Appendix B Parameter and Standard Area Definitions 

The descriptions that appear in the Parameter box of the Image Selection Dialog Box 
actually indicate aspects of how NIWA processed the data. The following table provides 
a description of the different parameters that might appear – and what they mean. 
Parameter Description 
Mean SST �C/R This indicates an SST analysis (either a daily or monthly 

analysis). The word “Mean” appears because it is computed 
from a number of individual orbital passes. 

Mean SST �C/R F02T05 This is a Monthly Mean SST anomaly analysis. 
HS Est SST An analysis from the SST Climatology 
Ch1, 0.6�m Albedo A visible GMS (or NOAA) satellite image  
Ch4, 11�m Temp An infrared GMS (or NOAA) satellite image  
Bathymetry/R Regional bathymetry. Depths in decametres (1 dm = 10 m) 

In future it is likely that the parameter names will be made more intuitive. 
The map below indicates the Standard Commercial Areas available via Sat-View.   
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Recreational areas may also be updated using Sat-View.   



 
 

Appendix C Products that may be updated from Sat-View  

As of February 2002, the following standard products may be updated using Sat-View: 
�� Daily SST analyses for all of the areas listed in Appendix B 
�� NZWATERS area GMS infrared satellite imagery for a region which covers local 

waters (see following example) 

 
This image is only 40 kilobytes in size – so it is not unrealistic to receive on a vessel 
connected to the internet by a satellite or cellphone connection. 
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Appendix D Colour Tables 

The following colour tables are provided with Sat-View. These may be used whenever 
you want to change the colours in the data products received from NIWA. 
 
Colour Table Name 

 
Data Range 

 
Description / Use 

SST0230 2 to 30 Uses the standard NIWA colour “ramp” to display SSTs 
between 2� C and 30� C. Only useful if you are viewing 
an analysis which covers a large latitude range – and 
hence a large temperature range.  

SST0525 5 to 25 The same as SST0230, except that the temperature range 
applied to the colour ramp is: 5� C and 25� C. Useful for 
looking at analyses over the whole NZ region. This colour 
table is used to produce the NZ Climatology data.  

SST1025 10 to 25 Again, the same as SST0230, except that the temperature 
range applied to the colour ramp is: 10� C and 25� C.  

SST2030 20 to 30 Again, the same as SST0230, except that the temperature 
range applied to the colour ramp is: 20� C and 30� C. Use 
this to look in detail at SSTs in this range. 

SST1626 16 to 26 Again, the same as SST0230, except that the temperature 
range applied to the colour ramp is: 16� C and 26� C. Use 
this to look in detail at SSTs in this range. 

SST1424 14 to 24 Again, the same as SST0230, except that the temperature 
range applied to the colour ramp is: 14� C and 24� C. Use 
this to look in detail at SSTs in this range. 

SST1222 12 to 22 Again, the same as SST0230, except that the temperature 
range applied to the colour ramp is: 12� C and 22� C. Use 
this to look in detail at SSTs in this range. 

SST1020 10 to 20 Again, the same as SST0230, except that the temperature 
range applied to the colour ramp is: 10� C and 20� C. Use 
this to look in detail at SSTs in this range. 

SST0818 8 to 18 Again, the same as SST0230, except that the temperature 
range applied to the colour ramp is: 8� C and 18� C. Use 
this to look in detail at SSTs in this range. 

SST0616 6 to 16 Again, the same as SST0230, except that the temperature 
range applied to the colour ramp is: 6� C and 16� C. Use 
this to look in detail at SSTs in this range. 
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Appendix E Quick Start Guide for Sat-View and Email 

Viewing Data in Sat-View

Start Sat-View  

To start the program, double click on the Sat-View icon .  
Caution: After starting Sat-View be careful not to click 
inside the main window showing the image of a NOAA 
satellite. This will crash the program, requiring you to 
restart it again. Once a data image has been selected 
this constraint dos not apply. This bug will be fixed in a 
future release. 

Viewing S andard Area SST and Cloud Imagery Data  t

i

iti

If you have just saved a new NIWA provided data file 
to the PC, then select Update Menu (from the File 
menu).  This updates all the menus in Sat-View. If you 
don’t do this, the most recent data file will not become 
available until a further 5 minutes have elapsed, then 

1) Choose Select (under the File menu). This 
brings up a window with three selection options. Select from left to right. 
a) The first is the type of data product, e.g., Mean SST. Click on the one required. 
b) The second indicates the areas for which this product is available. Click on the area 

required. 
c) The third shows the dates for which data are available for the chosen product and area. 

Click on the time required. 

Viewing User Def ned Area Data 
To visualise data for an area that you have defined (and received 
back from NIWA): 

1) Change to Areas view by selecting Areas from the View 
menu 

2) Use MB1 to select one of the boxes on the map. 

GPS Pos ons and SSTs 
Clicking on the image in the main window now gives the temperature 
and location of the pointer and the temperature at that location. 
You can indicate the position of the vessel on the SST map (i.e., with 
an anchor ), via the Ship Position dialog (from the File menu). 

Enlarging the Data 
To enlarge a section of the image – press the Right Mouse Button (MB2) – to bring up the Image 
view Popup menu, then choose Select View. Then, holding the left mouse button down (MB1) drag 
the pointer over the area to be enlarged. Release MB1. 

 32 



 

Identi ying Temperature Breaks (Drawing Cross-sections) f
To draw a cross-section (you must be in Image view mode): 

1) Use the right mouse button (MB2) to bring up the Popup 
menu, choose Draw Xsection (i.e. click on this option 
with MB1), then holding MB1 down, draw a line on the 
data image (where you want to see the SST cross-
section). 

with MB1), then holding MB1 down, draw a line on the 
data image (where you want to see the SST cross-
section). 

2) To see where any feature on the cross-section is on the 
image, just click (i.e. MB1) on the cross-section at the 
point of interest – a symbol will identify this position on 
the SST map, and the latitude, longitude, SST (and 
perhaps distance and bearing from anchor point 

2) To see where any feature on the cross-section is on the 
image, just click (i.e. MB1) on the cross-section at the 
point of interest – a symbol will identify this position on 
the SST map, and the latitude, longitude, SST (and 
perhaps distance and bearing from anchor point , if 
set) will appear in the message window.   

Updating User Defined Area Data 
1) Change to Areas view by selecting Areas from the View 

menu, then use one of the following methods: 
a) Either select an existing area as above, then order an 

update by clicking on Details, and filling in any 
missing fields.  Next, connect to the internet – and 
only then select Order Update. To save costs - once 
the order has been sent disconnect from the internet. 

b) Alternatively, use MB1 to draw a new box on the map
doing this using MB2 to bring up the Areas view Popup menu and using MB1 to 

 (you can enlarge the map before 

choose Select View etc.), fill out the missing / selectable details, connect to the internet, 
and select Order Update. To save costs - once the order has been sent disconnect from 
the internet. 

2) Be sure to select the Max image size of the data file you 
want to receive, and the Max cloud cover you are willing 
to accept. If you say 40% for the latter, and we compute 
(for example) that 45% of the area is cloud covered – then 
you will get a message back saying that 45% is cloud 
covered – and that no product has been sent. This saves 
on transmission costs. Of course, if you really do need to 
know what SSTs are looking like over the area, you can 
ask for the same area again (you will need to draw it 
again) – but set the cloud cover limit to some value 
greater than 45%, say 50% in this example. 

3) Be sure to disconnect from the internet as soon as the 
message has gone (i.e. when the black popup window has 
disappeared) 
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Receiving NIWA Data using Pegasus Mail
After you have requested data – it will be sent back to you via email. Data will normally be 
delivered within 60 minutes of the request being sent. The following instructions detail the steps to 
be taken by Pegasus (version 3) users to extract the data from the email message received from 
NIWA. If you are not using Pegasus see the section entitled Other mail programs below. 

Start Pegasus 

To start the program, double click on the Pegasus icon  and connect to the internet (or 
connect to the internet then start Pegasus – the order doesn’t matter). 

Receiving Mai  

1) Click on the  icon (or click on the 

 icon to both receive and send all 
mail (the latter is not recommended 
when using a slow internet connection, 
e.g., via Iridium or Inmarsat)), or 

2) Select Check host for new mail from 
the File menu unless you want to 
review details about the mail before 
downloading (it’s the download that 
costs the money) then: 
a) Select Selective mail download 

from the File menu. This will 
download the mail headers so 
you can see who has sent them 
and the subject etc. 

b) For those messages you don’t 
want to receive, click on them, 
then click on Mark for Deletion. 
When youc)  have identified all the 

3) The lder window will 

messages you don’t want to 
receive (as above) – then select 
Make it So. 
New mail fo

appear showing details as to who sent 
the message, the subject, date and 
time, and size of each mail message in 
kilobytes (as shown above right). 
Disconnect from the Internet as4)  the 

5) sage by double clicking on 

mail messages are now on your 
computer. 
Read a mes
it. If the message has an attachment 
(all NIWA SST and other data will be 
sent to you as one or more attachments 



 

to an email message) then: 
a) The top frame of the mail item message window (labelled: Contents of section 1) may 

or may not have some text in it – read this. If it is just technical verbage you can ignore 
it! 

b) The lower frame (labelled: Attachments, or other parts of this message) has the 
attachment details in it. Basically, you need to save the attachment to a file. To do this: 

i) Select the Graphic Image section (ignore the lines with the words Plain text) 
ii) Select the Save option (to the right of the lower frame window) 
iii) This brings up Export to 

which file dialog 
iv) Click on the Folder where you 

want to save the data (this 
should be the location 
specified when Sat-View was 
configured (via the 
Customize dialog) – normally 
c:\niwa\data). Make 
sure that it is going to save the 
file as a type GIF file or force 
it to. If the name in the File 
nam  window finishes with 
.gif or .GIF (as in the 
example here) then all is well, if it is not, and Save as t

e

ype says All files, then 
click in the File name window and add the characters .gif to the file name. 
Click Savev)  

6) To view the data in the most recent message, follow the instructions above (i.e., section 

Sendin

You can use Pegasus Mail to send email messages too. Click on the 

Viewing Data in Sat-View) 

g Mail with Pegasus 

 icon to compose a 

e mail message on your computer, ready to be sent the next time you 

When you next connect to the Internet stored messages may be sent by clicking on the 

message then click on Send.  
Note: This operation stores th
connect to the Internet. However, if you are actually connected to the Internet at the time you press 
the Send button – the message is sent from your computer to your ISP for forwarding to the 
recipient.  

 icon. 

her programs you need to:  

,  
rived since you last connected to the internet, and  

n the folder you 

Other mail programs 
For those users using ot
�� connect to the internet,  
�� start your email program
�� receive any mail that has ar
save the attachments to the NIWA messages to your computer’s hard disk i
specified in the customisation procedure, usually c:\niwa\data 
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Appendix F Usage Features and Known Problems 

Usage 
1) If recently saved images do not appear in the Image Selection box, use Update 

Menu to refresh the internal menu, or wait 5 minutes. 
2) Before selecting the Send it option in the Image order confirmation dialog, you 

must be logged onto the Internet. Use the dialer dialog provided by your ISP to 
logon to the Internet. To reduce your Internet charges, you should log off (the 
Internet) as soon as the mail message has been sent. This usually takes only a few 
seconds, and is signalled by the disappearance of the black popup window (with 
higher speed internet connections the window can appear and disappear very 
quickly).  

3) For the purposes of the cloud cover calculation (at NIWA), any land in the area is 
counted as cloud. When ordering data for a coastal area you should make 
allowance for this when setting the Max cloud cover in the Image details & 
ordering dialog (see Section 4.4). 

4) If the Colour scale option under the Options menu does not work properly, or 
you get error messages, consult the person who installed Sat-View as some files 
are likely to be missing or not accessible to Sat-View. 

5) Area outline(s) for user-defined areas only appear on the Areas display after data 
for the specified area(s) have been received and written to the folder specified in 
the Customize option. 

6) When ordering Standard NIWA products via the Order std products dialog Sat-
View does not honour the default maximum image size constraint set in the User 
Options under the Customize menu. This is not a bug. Standard products range 
in size from around 40 kilobytes for GMS satellite images for the NZWATERS 
area to 250 kilobytes for an SSTNZ area SST analysis. 

7) If the Show-3D does not bring up the array viewer, it probably has not been 
initialised. Try running it from the Windows Start menu (Programs � Compaq 
Array Visualizer � Array Viewer). 

Known Problems  
1) If the File Selection dialog box does not appear after the 3D viewer has been 

used (Section 5.3), and possibly on other occasions too, exit from the program 
and restart Sat-View. 

2) If two anchor symbols appear on the main window, change the magnification to a 
higher value, then back to the original value – this will remove the stray anchor. 

3) Under Windows XP, the Customize Save Options option brings up only part of 
the confirmation window. The words Update and Don’t update are not visible, 
but the top parts of the buttons are visible. Update is the on the left, click on the 
visible part of the button. 
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Appendix G NIWA Contacts 

For general enquiries regarding NIWA’s sea surface temperature and weather (cloud) 
imagery services, please contact: 

 
Dr Michael Uddstrom 
Principal Scientist, Meteorology & Remote Sensing 
Phone: +64 4 386-0365, Fax: +64 4 386-2153,  
email: m.uddstrom@niwa.co.nz 

 
For enquiries relating to installation of Sat-View software, contact: 

 
Mr Colin Tinker  
IT Support 
Phone: +64 4 386-0331 or +64 25 310372, Fax: +64 4 386-2153,  
email: c.tinker@niwa.co.nz 

 
For enquiries relating to the NIWA satellite data products web service, registration, and 
accounting, please contact: 

 
Mr Ryan Lea 
Web Assistant 
Phone: +64 7 859 1865, Fax: +64 7 856 0151 
email: r.lea@niwa.co.nz 

 

mailto:m.uddstrom@niwa.co.nz
mailto:c.tinker@niwa.co.nz
mailto:r.lea@niwa.co.nz
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